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Safety and approval information

This Micro Motion product complies with all applicable European directives when properly installed in accordance with the
instructions in this manual. Refer to the EU declaration of conformity for directives that apply to this product. The EU declaration
of conformity, with all applicable European directives, and the complete ATEX Installation Drawings and Instructions are available
on the internet at www.emerson.com or through your local Micro Motion support center.

Information affixed to equipment that complies with the Pressure Equipment Directive, can be found on the internet at
www.emerson.com.

For hazardous installations in Europe, refer to standard EN 60079-14 if national standards do not apply.

Other information

Full product specifications can be found in the product data sheet. Troubleshooting information can be found in the configuration
manual. Product data sheets and manuals are available from the Micro Motion web site at www.emerson.com.

Return policy

Follow Micro Motion procedures when returning equipment. These procedures ensure legal compliance with government
transportation agencies and help provide a safe working environment for Micro Motion employees. Micro Motion will not accept
your returned equipment if you fail to follow Micro Motion procedures.

Return procedures and forms are available on our web support site at www.emerson.com, or by phoning the Micro Motion
Customer Service department.

Emerson Flow customer service

Email:

• Worldwide: flow.support@emerson.com

• Asia-Pacific: APflow.support@emerson.com

Telephone:

North and South America Europe and Middle East Asia Pacific

United States 800-522-6277 U.K. 0870 240 1978 Australia 800 158 727

Canada +1 303-527-5200 The Netherlands +31 (0) 704 136
666

New Zealand 099 128 804

Mexico +41 (0) 41 7686
111

France 0800 917 901 India 800 440 1468

Argentina +54 11 4837 7000 Germany 0800 182 5347 Pakistan 888 550 2682

Brazil +55 15 3413 8000 Italy 8008 77334 China +86 21 2892 9000

Central & Eastern +41 (0) 41 7686
111

Japan +81 3 5769 6803

Russia/CIS +7 495 981 9811 South Korea +82 2 3438 4600

Egypt 0800 000 0015 Singapore +65 6 777 8211

Oman 800 70101 Thailand 001 800 441 6426

Qatar 431 0044 Malaysia 800 814 008

Kuwait 663 299 01

South Africa 800 991 390

Saudi Arabia 800 844 9564

UAE 800 0444 0684
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1 Before you begin

1.1 About this document
This document provides information about how to integrate a Micro Motion Model 5700
Ethernet EtherNet/IP transmitter with Rockwell RSLogix 5000.

Important
This manual assumes that the following conditions apply:
• The transmitter has been installed correctly and completely according to the

instructions in the transmitter installation manual

• The installation complies with all applicable safety requirements

• The user is trained in local and corporate safety standards

1.2 Related documentation
You can find all product documentation via the product documentation DVD shipped with
the product or at www.emerson.com.

• Micro Motion Model 5700 Product Data Sheet

• Micro Motion Model 5700 with Ethernet Transmitters: Installation Manual

• Micro Motion Model 5700 with Ethernet Transmitters: Configuration and Use Manual

• Modbus Interface Tool

• Hazardous area installation — see the approval documentation shipped with the
transmitter, or download the appropriate documentation
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2 Model 5700 transmitters in Ethernet
networks
You can install the Model 5700 transmitter in star, ring, or daisy-chain networks using
industrial-rated shielded Ethernet cables.

• Make sure that each cable is no longer than 328 ft (99.97 m).

• Connect the Model 5700 transmitter to the host system via a LAN (Local Area Network)
and not a WAN (Wide Area Network).

• Follow all network security best practices.

2.1 Star topology
Model 5700 transmitters can be installed in a star network.

Figure 2-1: Model 5700 star network

A. Programmable Logic Controller (PLC)
B. Model 5700 with Ethernet output
C. External Ethernet switch

Integration Guide Model 5700 transmitters in Ethernet networks
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2.2 Ring topology
Model 5700 transmitters can be installed in a ring network.

Figure 2-2: Model 5700 ring network

A. Programmable Logic Controller (PLC)
B. Model 5700 with Ethernet output
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2.3 Daisy-chain topology
Model 5700 transmitters can be installed in a daisy-chain network.

Figure 2-3: Model 5700 daisy-chain network

A. Programmable Logic Controller (PLC)
B. Model 5700 with Ethernet output

Integration Guide Model 5700 transmitters in Ethernet networks
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3 Integrate with RSLogix 5000

3.1 Integrate with Rockwell RSLogix 5000 versions
20 and later
If you have Rockwell RSLogix 5000 version 20 or later firmware and programming
software, use this section to load the Model 5700 Electronic Data Sheet (EDS) and
commission the device using the RSLogix 5000 programming package.

Prerequisites

If you are upgrading the EDS from an older version, unregister the old EDS first using the
RSLogix 5000 EDS Hardware Installation Tool at Tools > EDS Hardware Installation Tool.

Procedure

1. Download the EDS file using one of the following methods:

Option Description

Use a USB
memory
drive

a. Insert a USB memory drive into the Model 5700 Ethernet service
port.
The service port connection is located under the transmitter cap.

b. From the transmitter display, choose Menu > USB Options >
Transmitter > USB Drive > Download Support Files > EDS file.

c. Follow the menu to copy the EDS file to the memory drive.

d. Copy the zip file from the USB memory drive to the PC where
RSLogix 5000 is installed.

e. Unzip the file to a chosen location.

f. In RSLogix 5000, choose Tools > EDS Hardware Installation Tool
and register the Model 5700 EDS file.

Integration Guide Integrate with RSLogix 5000
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Option Description

Download
the file

a. Download the EDS from the Micro Motion Model 5700 Ethernet
product website.

b. Unzip the file to a chosen location.

c. In RSLogix 5000, choose Tools > EDS Hardware Installation Tool
and register the Model 5700 EDS file.

Use
RSLinx

a. Using RSLinx, start RSLinx Classic.

Note
The Model 5700 transmitter must be active on the EtherNet/IP
network.

b. Choose Communications > RSWho.

c. Expand the appropriate network card in the left panel tree.

d. From the device pane, right-click 5700 Transmitter.

e. Choose Upload EDS File from Device.

f. Follow the prompts from the Rockwell Automation's EDS Wizard
to register the EDS.

2. If you have an established RSLogix Ethernet network, skip this step. If not, follow
these steps to create a network:

a) From RSLogix 5000, right-click the controller/backplane in the tree view.

Integrate with RSLogix 5000 Integration Guide
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Example

b) Select New Module….

c) Select the appropriate Ethernet card.

d) Select Create.

e) Enter the Name.

f) Enter the IP Address.

g) Select the Slot where your Ethernet card is located.

h) Select OK.

i) On the Select Module Type window, select Close.

3. To add the Model 5700 Ethernet device to the RSLogix 5000 Ethernet network,
right-click the Ethernet network and select New Module…

Integration Guide Integrate with RSLogix 5000
MMI-20029770 March 2019
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Example

a) Select the Model 5700 from the Select Module Type window and press
Create.

Example

The New Module properties dialog is displayed. The EDS generates an Add
On Profile (AOP) for the Model 5700 that loads all the variables into the
controller's input and output image tables as named variables with the
correct data types.

b) Enter the Name of the module.

c) Enter the IP Address.

4. Change or keep the current connection type.

Integrate with RSLogix 5000 Integration Guide
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Option Description

To change the connection type Go to Step 5.

To keep the current connection type Go to Step 6.

5. From the General tab, change the connection type:

a) Select the Change… button.

Example

b) Click the current connection.

Default = Mass Flow In & Basic

A pull-down menu with all the available connection types is displayed. For
descriptions, see Table B-2.

Integration Guide Integrate with RSLogix 5000
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c) Select your appropriate connection, and press OK.

 CAUTION
If you change the connection after the device goes online, you will need to
take the controller offline in order for the change to take effect.

6. On the New Module properties dialog, click OK.

7. On the Select Module Type dialog, click Close.

8. Open Controller Tags to verify the organization of data.

Integrate with RSLogix 5000 Integration Guide
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3.2 Integrate with Rockwell RSLogix 5000 versions
19 and earlier
Use this section if you have Rockwell RSLogix 5000 version 19 or earlier firmware and
programming software. These early versions do not support the Model 5700 Electronic
Data Sheet (EDS)-generated Add On Profile (AOP). Instead, you must use the generic
module hardware tree.

Procedure

1. Download the EDS file using one of the following methods:

Option Description

Use a USB
memory
drive

a. Insert a USB memory drive into the Model 5700 Ethernet service
port.
The service port connection is located under the transmitter cap.

b. From the transmitter display, choose Menu > USB Options >
Transmitter > USB Drive > Download Support Files > EDS file.

c. Follow the menu to copy the EDS file to the memory drive.

d. Copy the zip file from the USB memory drive to the PC where
RSLogix 5000 is installed.

e. Unzip the file to a chosen location.

Download
the file

a. Download the EDS from the Micro Motion Model 5700 Ethernet
product website.

b. Unzip the file to a chosen location.

2. In RSLogix 5000, choose Tools > EDS Hardware Installation Tool and register the
Model 5700 EDS file.

3. If you have an established RSLogix Ethernet network, skip this step. If not, follow
these steps to create a network:

a) From RSLogix 5000, right-click the controller/backplane in the tree view.

Integration Guide Integrate with RSLogix 5000
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Example

b) Select New Module….

c) Select the appropriate Ethernet card.

d) Select Create.

e) Enter the Name.

f) Enter the IP Address.

g) Select the Slot where your Ethernet card is located.

h) Select OK.

i) On the Select Module Type window, select Close.

4. From RSLogix 5000, choose File > New.

5. Select your version from the Revision drop-down menu.

6. Enter a Name for your application.

7. Select the Slot where your Ethernet card is located.

8. Press OK.

9. From the By Vendor tab, select ETHERNET-MODULE Generic Ethernet Module.

Integrate with RSLogix 5000 Integration Guide
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Example

10. Select OK.

11. Select Data-DINT as the module data type.

12. Select the appropriate assembly instances for your application.

Enter the assembly numbers in the generic module setup, along with the data sizes
that are listed in Table B-1.

Example

a. Input = 101

b. Output = 150

c. Configuration = 1

Integration Guide Integrate with RSLogix 5000
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Note
The Model 5700 does not use a Configuration instance. Enter 1 in the
Assembly Instance column, and 0 length for the Size column.

13. Enter the IP Address of the Model 5700.

14. Press OK.

15. Open Controller Tags to see the data organization.

16. Use your preferred programming techniques to convert the data from the input and
output image tables to the correct data types.

• As the Model 5700 process variables are generally type REAL, use the COP
command to convert them.

• The byte ordering is correct, so no byte swapping is needed.

Integrate with RSLogix 5000 Integration Guide
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Example
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4 Use explicit (messaging) using the
Modbus Object
The programming for explicit variables is the same regardless of the controller firmware
version. Explicit messaging differs from implicit messaging in that the service code and
class refer to a Modbus data type rather than a specific data item. The message source
element provides the location of the desired data in the Model 5700's database. The only
difference is that the Common Industrial Protocol (CIP) message type refers to a type of
data in the Model 5700's internal database rather than a specific data item. The desired
data item is referenced as the Modbus address in the CIP message. The data item does not
have to be part of an assembly, so in the example in Figure 4-1, a batcher data item is
requested to be read.

• For more information about CIP message codes, see Modbus object (44HEX – 1
instance).

• For more information about Modbus addresses and their lengths, see the Modbus
Interface Tool (MIT) available at www.emerson.com.

Note
After finding a Modbus address in the MIT, subtract 1 from that address when
referencing it in the Msg in the following procedure.

Procedure

1. Create the Msg and select it.

2. Select the Source Element that was previously created as a controller scope tag.

Figure 4-1: Batch status message

Example

The following example shows a message that writes data to the Model 5700
database.

The Automatic Overshoot Compensation (AOC) value is a floating point number
that you will need to convert to integer format using a COP command prior to
referencing it in the Source Element of the message.

Integration Guide Use explicit (messaging) using the Modbus Object
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Combine the AOC value with the Model 5700 database (Modbus) address and
length to form the message's source element. This can be an array as shown in the
following graphic or a user-defined data type (UDT). The first element is the
Modbus address (zero based), the second is the length, and finally the data in
integer (INT) format.

The address and data length will be returned if the write is successful. For example,
Set_AOC_Rtn.

Use explicit (messaging) using the Modbus Object Integration Guide
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5 Use explicit (messaging) using the
Analog Input Object
As described in the previous chapter, explicit messaging using the Modbus object gives
the programmer access to all the data available in the Model 5700 database. A simpler
method than using the Modbus object to access process variable values, engineering
units, and status, is to use the standard Common Industrial Protocol (CIP) Analog Input
object.

Related information

Analog Input Point object (0AHEX-51 instances)

5.1 Read mass flow value example
The following example shows a message that reads the mass flow value using the mass
flow instance of the Analog Input class.

Procedure

1. Create the Msg and select it.

2. Enter A in the Class field.

The A comes from the Analog Input object class 0xA.

3. Use Analog Input Point object (0AHEX-51 instances) as a reference for the following
steps:

a) Enter the appropriate instance in the Instance field as a hexadecimal
number.

In this example, Mass Flow is Instance 1.

b) Enter the appropriate attribute in the Attribute field as a hexadecimal
number.

Integration Guide Use explicit (messaging) using the Analog Input Object
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In this example, the value parameter is Attribute 3.

5.2 Write mass flow example
The following example shows a message that writes the mass flow units using the mass
flow instance of the Analog Input class.

Procedure

1. Create the Msg and select it.

2. Enter A in the Class field.

The A comes from the Analog Input object class 0xA.

3. Use Analog Input Point object (0AHEX-51 instances) as a reference for the following
steps:

a) Enter the appropriate instance in the Instance field as a hexadecimal
number.

In this example, Mass Flow is Instance 1.

b) Enter the appropriate attribute in the Attribute field as a hexadecimal
number.

In this example, the engineering units parameter is Attribute 100 (64 Hex).

Use explicit (messaging) using the Analog Input Object Integration Guide
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A Assembly object (04HEX – 16
instances)

A.1 Class attributes
Class attributes (instance 0)

Attribute ID Name Data type Data value Access rule

1 Revision UINT 2 Get

2 Max instance UINT 255 Get

A.2 Input assemblies
Table A-1: Class attributes (Instances 100-110)

Attribute ID Name Data type Data value Access rule

3 Input data DWORD[varies] 0 Get

Table A-2: Common input data

Assembly
Dword
index

Name Data type

0 Mass Flow REAL

1 Temperature REAL

2 Density REAL

3 Drive Gain REAL

4 Totalizer 1 (default = Mass Total) REAL

5 Inventory 1 (default = Mass Inventory) REAL

6 Status DWORD

Severity • Bit #0 = Immediate Failure

• Bit #1 = Last Measure Value
Failure

• Bit #2 = Function Check

• Bit #3 = Out of Specification

• Bit #4 = Maintenance
Required

Integration Guide Assembly object (04HEX – 16 instances)
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Table A-2: Common input data (continued)

Assembly
Dword
index

Name Data type

Counter/Heartbeat (bits
16-32)

The PLC will display the
counter/heartbeat as a signed
INT, therefore the counter can
be negative.

7 Alert detail • Bit #0 = Electronics Failure

• Bit #1 = Sensor Failed

• Bit #2 = Configuration Error

• Bit #3 = Core Low Power

• Bit #4 = Security Breach

• Bit #5 = Sensor-Transmitter

DWORD

Communications error • Bit #6 = Tube Not Full

• Bit #7 = Extreme Primary
Purpose Variable

• Bit #8 = Reserved

• Bit #9 = Flowmeter
Initializing

• Bit #10 = Function Check in
Progress

• Bit #11 = Sensor Being
Simulated

• Bit #12 = Output Fixed

• Bit #13 = Drive Over Range

• Bit #14 = Process
Aberration

• Bit #15 = Discrete Event X
Active

• Bit #16 = Output Saturated

• Bit #17 = Function Check
Failed

• Bit #18 = Data Loss Possible

8 Echo Output Data Discrete Actions DWORD

Table A-3: Liquid volume flow

Assembly
Dword
index

Name Data type

0–8 Mass Flow See Table A-2

Assembly object (04HEX – 16 instances) Integration Guide
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Table A-3: Liquid volume flow (continued)

Assembly
Dword
index

Name Data type

9 Volume Flow REAL

10 Totalizer 2 (default = Volume Total) REAL

11 Inventory 2 (default = Volume Inventory) REAL

Table A-4: Gas volume flow

Assembly
Dword
index

Name Data type

0–8 Mass Flow See Table A-2

9 Gas Volume Flow REAL

10 Totalizer 4 (default = Gas Volume Total) REAL

11 Inventory 4 (default = Gas Volume Inventory) REAL

Table A-5: API Referral

Assembly
Dword
index

Name Data type

0–8 Mass Flow See Table A-2

9 Volume Flow REAL

10 Totalizer 2 (default = Volume Total) REAL

11 Inventory 2 (default = Volume Inventory) REAL

12 Corrected Density REAL

13 Corrected Vol Flow REAL

14 Totalizer 3 (default = Corrected Vol Total) REAL

15 Inventory 3 (default = Corrected Vol Inv) REAL

16 Avg Density REAL

17 Avg Temperature REAL

18 CTL REAL

Table A-6: Concentration Measurement

Assembly
Dword
index

Name Data type

0–8 Mass Flow See Table A-2

9 Volume Flow REAL
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Table A-6: Concentration Measurement (continued)

Assembly
Dword
index

Name Data type

10 Totalizer 2 (default = Volume Total) REAL

11 Inventory 2 (default = Volume Inventory) REAL

12 Density at Reference REAL

13 Std Vol Flow Rate REAL

14 Totalizer 5 (default = Std Vol Total) REAL

15 Inventory 5 (default = Std Vol Inv) REAL

16 Net Mass Flow Rate REAL

17 Totalizer 6 (default = Net Mass Total) REAL

18 Inventory 6 (default = Net Mass Inv) REAL

19 Net Vol Flow Rate REAL

20 Totalizer 7 (default = Net Vol Flow Total) REAL

21 Inventory 7 (default = Net Vol Flow Inv) REAL

22 Concentration REAL

23 Density - Fixed SG Units REAL

24 Density - Fixed Baume Units REAL

Table A-7: Batcher

Assembly
Dword
index

Name Data type

0–8 Mass Flow See Table A-3

9–11 Liquid Volume

12 Batch Total REAL

13 Overshoot Compensation Value (Reg 1457) REAL

14 Batch Fill Time REAL

Assembly object (04HEX – 16 instances) Integration Guide
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Table A-7: Batcher (continued)

Assembly
Dword
index

Name Data type

15 Fill status and diagnostics

• Bit #0 - Primary Fill in progress (reg 2495 bit 0)

• Bit #1 - Primary AOC training (reg 2495 bit 9)

• Bit #2 = Primary Valve (reg 2495 bit 5

• Bit #3 = Undefined

• Bit #4 = Undefined

• Bit #5 = Undefined

• Bit #6 - Fill Start Not Okay (reg 2496 bit 0)

• Bit #7 - AOC Flow Rate Too High (reg 2496 bit 1)

• Bit #8 - Maximum Fill Time Exceeded (reg 2496 bit
2)

• Bit #9 - Slug Flow (reg 2496 bit 3)

• Bit #10 - Tube Not Full (reg 2496 bit 4)

• Bit #11 - Drive Overrange (reg 2496 bit 5)

• Bit #12 - Critical Sensor Failure (reg 2496 bit 6)

• Bit #13 - Critical Transmitter Failure (reg 2496 bit 7)

• Bit #14 - Density Out of Limits (reg 2496 bit 8)

• Bit #15 - Temperature Out of Limits (reg 2496 bit 9)

• Bit #16 - Bit #31 for future expansion

DWORD

Table A-8: Small input configurable data set

Assembly
Dword
index

Name Data type

0–8 Mass Flow See Table A-2

9–16 8 configurable slots REAL *8

Table A-9: Medium input configurable data set

Assembly
Dword
index

Name Data type

0–8 Mass Flow See Table A-2

9–24 16 configurable slots REAL *16
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Table A-10: Large input configurable data set

Assembly
Dword
index

Name Data type

0–8 Mass Flow See Table A-2

9–40 32 configurable slots REAL *32

Table A-11: Advanced Phase Measurement (APM) – liquid

Assembly
Dword
index

Name Data type

0–8 Mass Flow See Table A-2

9 Volume Flow REAL

10 Totalizer 2 (default = Volume Total) REAL

11 Inventory 2 = (default = Volume Inventory) REAL

12 Gas Void Fraction REAL

13 Contract Total 1 REAL

14 Contract Total 2 REAL

15 Contract Total 3 REAL

16 Contract Total 4 REAL

17 Net Oil Flow @ Line REAL

18 Net Water Flow @ Line REAL

19 Watercut @ Line REAL

20 Net Oil Total @ Line REAL

21 Net Water Total @ Line REAL

22 Density Oil @ Line REAL

23 Net Oil Flow @ Ref REAL

24 Net Water Flow @ Ref REAL

25 Watercut @ Ref REAL

26 Net Oil Total @ Ref REAL

27 Net Water Total @ Ref REAL

Table A-12: Advanced Phase Measurement (APM) – gas volume

Assembly
Dword
index

Name Data type

0–8 Mass Flow See Table A-2

9 Gas Volume Flow REAL
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Table A-12: Advanced Phase Measurement (APM) – gas volume (continued)

Assembly
Dword
index

Name Data type

10 Totalizer 4 (default = Gas Volume Total) REAL

11 Inventory 4 (default = Gas Volume Inventory) REAL

12 Contract Total 1 REAL

13 Contract Total 2 REAL

14 Contract Total 3 REAL

15 Contract Total 4 REAL

16 Total time mist detected DWORD

17 APM Status

• Bit #0 – TMR Algorithm Active (reg 433 bit 12)(1)

• Bit #1 – Bit #15 currently not defined

• Bit #16 – Bit #31 for future expansion

DWORD

18 Liquid Mass Flow Estimate REAL

(1) Do not include the parenthesis in the label
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A.3 Output assemblies
Table A-13: Common output data — Discrete actions only

Assembly
Dword
index

Name Data type

0 • Bit #0 – Start Sensor Zero (trigger start with a 1, no abort)

• Bit #1 – Reset All Process Totals (same as setting bits
2-8)v

• Bit #2 – Reset Totalizer 1 (Mass Total by default)

• Bit #3 – Reset Totalizer 2 (Volume Total by default)

• Bit #4 – Reset Totalizer 3 (PM Ref Vol Total by default)

• Bit #5 – Reset Totalizer 4 (GSV Total by default)

• Bit #6 – Reset Totalizer 5 (CM Ref Vol Total by default)

• Bit #7 – Reset Totalizer 6 (CM Net Mass Total by default)

• Bit #8 – Reset Totalizer 7 (CM Net Vol Total by default)

• Bit #9 – Start All Totals (trigger start with a 1)

• Bit #10 – Stop All Totals (trigger stop with a 1)
If both start and stop =1, then totals are stopped

• Bit #11 – Start Smart Meter Verification (Continue
Measuring Mode only)
Trigger start with a 1, no abort

• Bit #12 – Reset all Inventory Totals

DWORD

Table A-14: External process data

Assembly
Dword
index

Name Data type

0 Common output data (instance 150 data) See Table A-13

1 External Pressure REAL

2 External Temperature REAL

Table A-15: Batcher

Assembly
Dword
index

Name Data type

0 Common output data (instance 150 data) See Table A-13

1 Batch Target REAL
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Table A-15: Batcher (continued)

Assembly
Dword
index

Name Data type

2 Batcher Control – Discrete Actions

• Bit #0 – Reserved

• Bit #1 – Start Fill

• Bit #2 – End Fill

• Bit #2 – Pause Fill

• Bit #4 – Resume Fill

• Bit #5 – Reserved

• Bit #6 – Start Training

• Bit #7 – Save AOC Calibration

• Bit #8 –Reset Batch Total

• Bit #9 – Print Batch Ticket

• Bit #10 – Reset Preset 1 Inventory

• Bit #11 – Reset Preset 2 Inventory

• Bit #12 – Reset Preset 3 Inventory

• Bit #13 – Reset Preset 4 Inventory

• Bit #14 – Reset Preset 5 Inventory

• Bit #15 – Reset Preset 6 Inventory

• Bit #16 – Inhibit Totalizer

• Bit #17 – Inhibit Flow

• Bit #18 – Inhibit Batch

• Bit #19 – Bit #31 for future expansion

DWORD

3 Maximum Batch Time (Reg 1305) REAL

Table A-16: Batcher and external process data

Assembly
Dword
index

Name Data type

0–2 External process data (instance 151 data) See Table A-13

3 Batch Target REAL
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Table A-16: Batcher and external process data (continued)

Assembly
Dword
index

Name Data type

4 Batcher Control – Discrete Actions

• Bit #0 – Reserved

• Bit #1 – Start Fill

• Bit #2 – End Fill

• Bit #2 – Pause Fill

• Bit #4 – Resume Fill

• Bit #5 – Reserved (for Clean in Place)

• Bit #6 – Start Training

• Bit #7 – Save AOC Calibration

• Bit #8 –Reset Batch Total

• Bit #9 – Print Batch Ticket

• Bit #10 – Reset Preset 1 Inventory

• Bit #11 – Reset Preset 2 Inventory

• Bit #12 – Reset Preset 3 Inventory

• Bit #13 – Reset Preset 4 Inventory

• Bit #14 – Reset Preset 5 Inventory

• Bit #15 – Reset Preset 6 Inventory

• Bit #16 – Inhibit Totalizer

• Bit #17 – Inhibit Flow

• Bit #18 – Inhibit Batch

• Bit #19 – Bit #31 for future expansion

DWORD

5 Maximum Batch Time (Reg 1305) REAL

Table A-17: Output configurable data

Assembly
Dword
index

Name Data type

0 Common output data (instance 150 data) See Table A-13

1 Configurable Slot 1 (Register) REAL

2 Configurable Slot 2 (Register) REAL

3 Configurable Slot 3 (Register) REAL

4 Configurable Slot 4 (Register) REAL

5 Configurable Slot 5 (Register) WORD

6 Configurable Slot 6 (Register) WORD
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Table A-17: Output configurable data (continued)

Assembly
Dword
index

Name Data type

7 Configurable Slot 7 (Register) WORD

8 Configurable Slot 8 (Register) WORD

9 Configurable Slot 9 (Coil) BOOL

10 Configurable Slot 10 (Coil) BOOL

11 Configurable Slot 11 (Coil) BOOL

12 Configurable Slot 12 (Coil) BOOL

Table A-18: Advanced Phase Measurement (APM)

Assembly
Dword
index

Name Data type

0 Common output data (instance 150 data) See Table A-13

1 External Pressure REAL

2 External Temperature REAL

3 External Water Cut REAL

A.4 Output Only Heartbeat (instance 253)
Use of this instance number in place of an input assembly instance number allows I/O
connections to only write data to the Model 5700 transmitter without any input data
returned.

If not practical, remove this instance.

A.5 Input Only Heartbeat (instance 254)
Use of this instance number in place of an output assembly instance number allows I/O
connections to monitor the input data from the Model 5700 transmitter without providing
any output data, called an “input only” connection. Conceptually, input-only connections
are used when HMIs or monitoring systems need to track input data, while still allowing a
Programmable Logic Controller (PLC) to provide the control side, or write the outputs.

This connection type is required per the Recommended Functionality for EtherNet/IP Devices
document.

For more information about Input Only connections, see Volume 1 of the ODVA
Specification (Common Industrial Protocol).
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A.6 Listen Only Heartbeat (instance 255)
Much like Input Only connections, Listen Only connections use this instance number in
place of an output assembly instance number to open an I/O connection. The I/O
connection monitors the input data from the Model 5700 transmitter. Existing I/O
connections have dependencies for allocation and timeouts that are different than Input
Only connections.

A.7 Usage notes
All output assemblies contain a common data as outlined in assembly instance 150. To
maintain proper ownership of the output data (no toggling of outputs between multiple
sources), only a single output assembly may be selected for use in I/O messaging. To
achieve this, there is an output lock in place to mark all output assemblies as “owned”
even though only a single assembly is actually in use.

All input instances can properly co-exist since no ownership is required. While not practical
for most applications, multiple PLCs can theoretically open Input Only connections to any
or all of the input assembly instances, up to the maximum number of I/O connections
supported.

A.8 Common services
Service code Implemented for Service name

Class level Instance level

0EHEX Yes Yes Get_Attribute_Single

10HEX No Yes Set_Attribute_Single
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B Assembly connections
Table B-1: Input and output assemblies

Input assembly instance Size (32-
bit)

Output assembly instance Size (32-
bit)

For definitions, see Input assemblies For definitions, see Output assemblies

100 – Basic Data 9 150 – Basic Data 1

101 – Liquid Volume 12 151 – External Process Data 3

102 – Gas Standard Volume 12 152 – Batcher 4

103 – API Referral 19 153 – Batcher and External
Process Data

6

104 – Concentration
Management

25 154 – Configurable Data Set 13

105 – Batcher 16 155 – APM External Process Data 4

106 – Small Configurable Data Set 17

107 – Medium Configurable Data
Set

25 253 – Output Only Heartbeat 0

108 – Large Configurable Data
Set

41 254 – Input Only Heartbeat 0

109 – APM – Liquid Volume 28 255 – Listen Only Heartbeat 0

110 – APM – Gas Volume 18

Table B-2: Connection types

ID Name Input assembly instance Output assembly instance

For definitions, see Input
assemblies

For definitions, see Output
assemblies

1 Mass Flow In & No Out 100 – Basic Data 254 – Input Only Heartbeat

2 Mass Flow In & Basic Out 100 – Basic Data 150 – Basic Data

3 Mass Flow In & External Data
Out

100 – Basic Data 151 – External Process Data

4 Mass Flow In (Listen Only) 100 – Basic Data 255 – Listen Only Heartbeat

5 Volume Flow In & No Out 101 – Liquid Volume 254 – Input Only Heartbeat

6 Volume Flow In & Basic Out 101 – Liquid Volume 150 – Basic Data

7 Vol Flow In & External Data
Out

101 – Liquid Volume 151 – External Process Data

8 Volume Flow In (Listen Only) 101 – Liquid Volume 255 – Listen Only Heartbeat

9 GSV In & No Out 102 – Gas Standard Volume 254 – Input Only Heartbeat

10 GSV In & Basic Out 102 – Gas Standard Volume 150 – Basic Data
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Table B-2: Connection types (continued)

ID Name Input assembly instance Output assembly instance

For definitions, see Input
assemblies

For definitions, see Output
assemblies

11 GSV In & External Data Out 102 – Gas Standard Volume 151 – External Process Data

12 GSV In (Listen Only) 102 – Gas Standard Volume 255 – Listen Only Heartbeat

13 API In & No Out 103 – API Referral 254 – Input Only Heartbeat

14 API In & Basic Out 103 – API Referral 150 – Basic Data

15 API In & External Data Out 103 – API Referral 151 – External Process Data

16 API In (Listen Only) 103 – API Referral 255 – Listen Only Heartbeat

17 CM In & No Out 104 – Concentration
Measurement

254 – Input Only Heartbeat

18 CM In & Basic Out 104 – Concentration
Measurement

150 – Basic Data

19 CM In & External Data Out 104 – Concentration
Measurement

151 – External Process Data

20 CM In (Listen Only) 104 – Concentration
Measurement

255 – Listen Only Heartbeat

21 Batcher In & Batcher Out 105 – Batcher 152 – Batcher

22 Batcher In & External Data
Out

105 – Batcher 153 – Batcher and External
Data

23 Batcher In (Listen Only) 105 – Batcher 255 – Listen Only Heartbeat

24 Small Config In & No Out 106 – Small Configurable
Data Set

254 – Input Only Heartbeat

25 Small Config In & Config Out 106 – Small Configurable
Data Set

154 – Configurable Data Set

26 Medium Config In & No Out 107 – Medium Configurable
Data Set

254 – Input Only Heartbeat

27 Medium Config In & Config
Out

107 – Medium Configurable
Data Set

154 – Configurable Data Set

28 Large Config In & No Out 108 – Large Configurable
Data Set

254 – Input Only Heartbeat

29 Large Config In & Config Out 108 – Large Configurable
Data Set

154 – Configurable Data Set

30 Large Config In (Listen Only) 108 – Large Configurable
Data Set

255 – Listen Only Heartbeat

31 APM Liquid In & No Out 109 - APM Liquid 254 – Input Only Heartbeat

32 APM Liquid In & Basic Out 109 - APM Liquid 150 – Basic Data

33 APM Liquid In & APM Out 109 - APM Liquid 155 – APM External Process
Data

34 APM Liquid In (Listen Only) 109 - APM Liquid 255 – Listen Only Heartbeat
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Table B-2: Connection types (continued)

ID Name Input assembly instance Output assembly instance

For definitions, see Input
assemblies

For definitions, see Output
assemblies

35 APM Gas In & No Out 110 - APM Gas 254 – Input Only Heartbeat

36 APM Gas In & Basic Out 110 - APM Gas 150 – Basic Data

37 APM Gas In & APM Out 110 - APM Gas 155 – APM External Process
Data

38 APM Gas In (Listen Only) 110 - APM Gas 255 – Listen Only Heartbeat
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C Modbus object (44HEX – 1 instance)
The Modbus object provides a “pass through” to the internal Modbus representation of
any data point. All validation related to addressing, length, or write validation is handled
by the Modbus DLL.

C.1 Modbus class attributes
Attribute ID Name Data type Data value Access rule

1 Revision UINT 3 Get

C.2 Instance attributes
No instance attributes are defined.

C.3 Common services
Service code Implemented for Service name

Class level Instance level

0EHEX Yes Yes Get_Attribute_Single

4BHEX No Yes Read_Discrete_Inputs

4CHEX No Yes Read_Coils

4DHEX No Yes Read_Input_Registers

4EHEX No Yes Read_Holding_Registe
rs

4FHEX No Yes Write_Coils

50HEX No Yes Write_Holding_Regist
ers

4BHEX Read_Discrete_Inputs (Modbus FC 0x02)

Table C-1: Request format

Name Data type Description Semantics

Starting address UINT Offset in table to begin
reading from

Zero-based

Quantity of inputs UINT Number of inputs to
read

1-2000
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Table C-2: Response format

Name Data type Description Semantics

Input status BYTE[n] Input values read 8 inputs are packed
into each byte

4CHEX Read_Coils (Modbus FC 0x01)

Table C-3: Request format

Name Data type Description Semantics

Starting address UINT Offset in table to begin
reading from

Zero-based

Quantity of inputs UINT Number of coils to read 1-2000

Table C-4: Response format

Name Data type Description Semantics

Coil status BYTE[n] Input values read 8 coils are packed into
each byte

4DHEX Read_Input_Registers (Modbus FC 0x04)

Table C-5: Request format

Name Data type Description Semantics

Starting address UINT Offset in table to begin
reading from

Zero-based

Quantity of input
registers

UINT Number of input
registers to read

1-125

Table C-6: Response format

Name Data type Description Semantics

Input register values WORD[n] Input register values
read

Data swap to convert
between little endian
(CIP) and big endian
(Modbus)

4EHEX Read_Holding_Registers (Modbus FC 0x03)

Table C-7: Request format

Name Data type Description Semantics

Starting address UINT Offset in table to begin
reading from

Zero-based

Quantity of input
registers

UINT Number of input
registers to read

1-125

Modbus object (44HEX – 1 instance) Integration Guide
March 2019 MMI-20029770

46 Micro Motion Model 5700 EtherNet/IP transmitters



Table C-8: Response format

Name Data type Description Semantics

Holding register values WORD[n] Holding register values
read

Data swap to convert
between little endian
(CIP) and big endian
(Modbus)

4FHEX Write_Coils (Modbus FC 0x0F)

Table C-9: Request format

Name Data type Description Semantics

Starting address UINT Offset in table to begin
writing to

Zero-based

Quantity of outputs UINT Number of output coils
to write

1-2000

Output values BYTE[n] Output coils values

Table C-10: Response format

Name Data type Description Semantics

Starting address UINT Offset in table where
writing began

Zero-based

Quantity of outputs UINT Number of output coils
written

50HEX Write_Holding_Registers (Modbus FC 0x10)

Table C-11: Request format

Name Data type Description Semantics

Starting address UINT Offset in table to begin
writing to

Zero-based

Quantity of outputs UINT Number of output coils
to write

1-125

Output values WORD[n] Output register values

Table C-12: Response format

Name Data type Description Semantics

Starting address UINT Offset in table where
writing began

Zero-based

Quantity of outputs UINT Number of output
resisters written
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D Analog Input Point object (0AHEX-51
instances)
Attributes

Attribute ID Name Notes

3 Value Data type = REAL
Read Only

4 Status 0 = Good
1 = Alarm State
Read Only

8 Value Data Type 1 = REAL
Read Only

100 Engineering Units Data type = UINT (see Engineering
units for codes)
Read/Write

Services

Service code Name

0x0E Get Attribute Single

0x10 Set Attribute Single

Instances

Instance in decimal Instance in hex Name

1 0x01 Mass Flow

2 0x02 Volume Flow

3 0x03 Density

4 0x04 Temperature

5 0x05 Gas Standard Volume Flow

6 0x06 Drive Gain (units = % only)

7 0x07 PM: Corrected Density

8 0x08 PM: Corrected Volume Flow

9 0x09 PM: Average Density

10 0x0A PM: Average Temperature

11 0x0B CM: Density at Reference

12 0x0C CM: Standard Volume Flow Rate

13 0x0D CM: Net Mass Flow Rate

14 0x0E CM: Net Volume Flow Rate
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Instance in decimal Instance in hex Name

15 0x0F CM: Concentration

16 0x10 BATCHER: Batch Total

17 0x11 Totalizer 1

18 0x12 Totalizer 2

19 0x13 Totalizer 3

20 0x14 Totalizer 4

21 0x15 Totalizer 5

22 0x16 Totalizer 6

23 0x17 Totalizer 7

24 0x18 Inventory 1

25 0x19 Inventory 2

26 0x1A Inventory 3

27 0x1B Inventory 4

28 0x1C Inventory 5

29 0x1D Inventory 6

30 0x1E Inventory 7

31 0x1F APM: Gas Void Fraction (units = % only)

32 0x20 APM: Contract Total 1

33 0x21 APM: Contract Total 2

34 0x22 APM: Contract Total 3

35 0x23 APM: Contract Total 4

36 0x24 APM: Net Oil Flow @ Line

37 0x25 APM: Net Water Flow @ Line

38 0x26 APM: Water Cut @ Line

39 0x27 APM: Net Oil Total @ Line

40 0x28 APM: Net Water Total @ Line

41 0x29 APM: Density Oil @ Line

42 0x2A APM: Net Oil Flow @ Reference

43 0x2B APM: Net Water Flow @ Reference

44 0x2C APM: Water Cut @ Reference

45 0x2D APM: Net Oil Total @ Reference

46 0x2E APM: Net Water Total @ Reference

47 0x2F External Temperature

48 0x30 External Pressure
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Instance in decimal Instance in hex Name

49 0x31 External Water Cut (units = % only)

50 0x32 APM: Unremediated Mass Flow

51 0x33 APM: Unremediated Volume Flow

Engineering units

Table D-1: General

Name Value in hex

Special Units 0x080F

percent 0x1007

Table D-2: Mass Flow

Name Value in hex

grams per second 0x1437

grams per minute 0x140F

grams per hour 0x1436

kilograms per second 0x1404

kilograms per minute 0x1445

kilograms per hour 0x1410

kilograms per day 0x1444

metric tons per minute 0x1463

metric tons per hour 0x1462

metric tons per day 0x1461

pounds per second 0x140B

pounds per minute 0x140C

pounds per hour 0x140D

pounds per day 0x145C

short tons per minute 0x1482

short tons per hour 0x1481

short tons per day 0x1480

long tons per hour 0x1475

long tons per day 0x1474

Table D-3: Mass

Name Value in hex

grams 0x2501
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Table D-3: Mass (continued)

Name Value in hex

kilograms 0x2500

metric tons 0x2503

pounds 0x2505

short tons 0x2506

long tons 0x2507

liters per second 0x1406

liters per minute 0x1413

liters per hour 0x1414

million liters per day 0x0802

cubic feet per second 0x1467

cubic feet per minute 0x1402

cubic feet per hour 0x1466

cubic feet per day 0x1465

cubic meters per second 0x0803

cubic meters per minute 0x1433

cubic meters per hour 0x1432

cubic meters per day 0x1431

gallons per second 0x1408

gallons per minute 0x1409

gallons per hour 0x140A

gallons per day 0x1434

million gallons per day 0x1447

imperial gallons per second 0x1443

imperial gallons per minute 0x1442

imperial gallons per hour 0x1441

imperial gallons per day 0x1440

barrels per second 0x1420

barrels per minute 0x141F

barrels per hour 0x141E

barrels per day 0x141D

beer barrels per second 0x141C

beer barrels per minute 0x141B

beer barrels per hour 0x141A
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Table D-3: Mass (continued)

Name Value in hex

beer barrels per day 0x1419

Table D-4: Liquid Volume

Name Value in hex

liters 0x2E02

cubic feet 0x2E06

cubic meters 0x2E01

gallons 0x2E08

imperial gallons 0x2E15

barrels 0x2E0C

beer barrels 0x2E0E

normal liter per second 0x1457

normal liter per minute 0x1456

normal liter per hour 0x1455

normal liter per day 0x1454

standard liter per second 0x080C

standard liter per minute 0x1401

standard liter per hour 0x080B

standard liter per day 0x080A

normal cubic meter per second 0x1453

normal cubic meter per minute 0x1452

normal cubic meter per hour 0x1451

normal cubic meter per day 0x1450

standard cubic meter per second 0x1460

standard cubic meter per minute 0x145F

standard cubic meter per hour 0x145E

standard cubic meter per day 0x145D

standard cubic feet per second 0x146C

standard cubic feet per minute 0x146D

standard cubic feet per hour 0x146E

standard cubic feet per day 0x146F
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Table D-5: Gas Volume

Name Value in hex

normal liter 0x2E19

standard liter 0x0813

normal cubic meter 0x2E22

standard cubic meter 0x2E1A

standard cubic feet 0x2E1E

specific gravity units 0x0804

grams per cubic centimeter 0x2F08

grams per liter 0x2F0F

grams per milliliter 0x2F0E

kilograms per cubic meter 0x2F07

kilograms per liter 0x2F10

pounds per gallon 0x2F0B

pounds per cubic foot 0x2F0C

pounds per cubic inch 0x2F0D

short tons per cubic yard 0x0807

degrees API 0x3000

Table D-6: Density

Name Value in hex

specific gravity units 0x0804

grams per cubic centimeter 0x2F08

grams per liter 0x2F0F

grams per milliliter 0x2f0E

kilograms per cubic meter 0x2F07

kilograms per liter 0x2F10

pounds per gallon 0x2F0B

pounds per cubic foot 0x2F0C

pounds per cubic inch 0x2F0D

short tons per cubic yard 0x0807

degrees API 0x3000

Table D-7: Temperature

Name Value in hex

Degrees Celsius 0x1200
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Table D-7: Temperature (continued)

Name Value in hex

Degrees Fahrenheit 0x1201

Kelvin 0x1202

Degrees Rankine 0x1203

Table D-8: Pressure

Name Value in hex

inches of Water at 60degF 0x0809

inches of Water at 68 degF 0x0800

inches of Water at 4degC 0x080D

feet of water at 68 degF 0x1311

millimeters of Water at 68 degF 0x130F

inches of Mercury at 0 degC 0x1304

millimeters of Mercury at 0 degC 0x1303

millimeters of Water at 4 degC 0x080E

psi 0x1300

bar 0x1307

millibar 0x1308

pascal 0x1309

kilopascal 0x130A

megapascals 0x1312

atmosphere 0x130B

torr 0x1301

gram per square centimeter 0x130C

kilogram per square centimeter 0x1314

Degrees Twaddell 0x0810

Degrees Balling 0x320A

Degrees Brix 0x320D

Degrees Baume (heavy) 0x320B

Degrees Baume (light) 0x320C

% solids per weight (% mass) 0x2F2F

% solids per volume (% volume) 0x2F2C

Proof per volume 0x0811

Proof per mass 0x0812

Percent Plato 0x320E
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Table D-9: Concentration

Name Value in hex

Degrees Twaddell 0x0810

Degrees Balling 0x320A

Degrees Brix 0x320D

Degrees Baume (heavy) 0x320B

Degrees Baume (light) 0x320C

% solids per weight (% mass) 0x2F2F

% solids per volume (% volume) 0x2F2C

Proof per volume 0x0811

Proof per mass 0x0812

Percent Plato 0x320E

Related information

Use explicit (messaging) using the Analog Input Object
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